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ABSTRACT
This project addressed the need to develop a

handbook, using the Microsoft Office XP suite of products,

for use in the classroom by teachers. The literature
review outlines the increasing importance of computer

technology in today's modern classroom, both for student
use as well as that of teachers. Over 80% of the teachers
in the profession today received their formal education

prior to the beginning of the information age,

it is

imperative that these teachers enhance their existing
skill set with the knowledge of how they can use

technology to support their own administration support.

In

so doing, these teachers can become more efficient and

effective at performing these tasks which will provide

them with time to develop to preparing and delivering
instruction. To accomplish this goal, teachers were

sampled to identify five computer projects using Microsoft
Office XP they would like learn, and would allow them, in
turn, to become more efficient and effective.

Another challenge for teachers is finding the time to

take the computer courses which would allow them to

develop the skills and confidence to integrate computer
technology into their classrooms. Given this,

the

computerized projects are included in a step-by-step
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handbook which can be easily referenced and mastered, and
therefore, are not constrained by time, Each project
provides step-by-step instructions with graphics to assist
the teacher in the use of the software.
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CHAPTER ONE
BACKGROUND

Introduction

Chapter One presents an overview of the project. The
contents of the problem are discussed followed by the . -

purpose, significance of the project,
Next,

and assumptions.

the limitations and delimitations that apply to the

project are reviewed. Finally, definitions of terms are
presented.

Purpose of the Project

The purpose of the project was to develop a teacher

handbook to using computer technology and the Microsoft
Office XP software in the performance of their

administrative tasks. The handbook was designed to provide
teachers with step-by-step instructions that would enable

them to automate many administrative tasks that were
previously performed manually, without the benefit of

computer technology.

Context of the Problem
There is a significant need for teachers to integrate

computer technologies and related educational software
when performing their work responsibilities.

In so doing,

teachers will be able to incorporate greater efficiency
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and effectiveness when performing these tasks, and will

ultimately have more time to devote to teaching students

instead of tracking and reporting on student performance.
In his book, The Road Ahead, Bill Gates made the

statement,

"One thing is clear. We don't have the option

of turning away from the future. No one gets to vote on

whether technology is going to change our lives"
p.

(1995,

74). This statement is as true for educators as it is

for business leaders who use computers to lead

multimillion-dollar companies. Computer technology is
available in classrooms and it is impacting the way
teachers think about teaching and all that it entails
(Hasselbring et al., 2000). Teachers also serve as role

models for students. It is easy to recall those teachers
who have had an impact on your life. While the reasons may
vary,

it is important to be mindful of the example

teachers set and the impressions they make on a student's

life.

It is for these reasons that teachers need to

demonstrate their computer literacy by using the computer
in the performance of their job duties.

The specific context of the problem was to address

the problem where teachers are not taking advantage of the

computer technology available today which will allow them
to increase their productivity and allow them to provide
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more comprehensive information because they will be able,

to drill down on data, and create highly informative

reports for parents, students,

school administrators and

themselves, at the click of a button.

Significance of the Project

The significance of the project was to design a
handbook that covers various routine tasks that are being
performed manually by teachers, and which if automated,

could increase the teachers' productivity and the quality
of the work being produced through the successful use of

computer technology, and Microsoft Office software.
According to a study published in October 2000 by the
CBEDS, approximately forty-four percent of the teachers in

California were 46 years of age or older. The significance
of this statistic is that the majority of teachers in

California received their education before computer

literacy courses were required as part of there course of
study. One can only conclude that in order for these
teachers to incorporate the use of computer technology to

support the delivery of instruction,

the teachers need to

be trained. This is why many teachers feel uncomfortable

integrating technology into their classroom because they
do not possess the skills and knowledge necessary to use
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the computer technology and the Microsoft Office XP

software. Beyond this, most teachers do not want, or have ■
the time to enroll in course to develop computer skills

and knowledge that may or may not meet their unique needs.

The real value of the handbook is that the projects were
specifically selected and developed to meet the needs of a
teacher, using the Microsoft Office XP software, because .
of its ease of use and market penetration throughout the

United States.

Assumptions
The following assumptions were made regarding the

proj ect:
1.

Teachers using the handbook will possess the

basic knowledge on how to operate a personal

computer including creating, modifying, printing
and saving files.
2.

Teachers using the handbook will have some

knowledge of Microsoft Word and Excel,
specifically in the areas of formatting, and
opening and saving files.
3.

Teachers will have access to a IBM compatible

personal computer, loaded with Microsoft Office
XP.
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Limitations and Delimitations

During the development of the project, a number of

limitations and delimitations were noted. These

limitations and delimitations are presented in the next
section.

Limitations

The following limitations apply to the project:
1.

The curriculum section of the handbook was

designed for use with the Microsoft Office XP
Suite of products.

2.

The handbook was limited to teacher needs.

Delimitations

The following delimitations apply to the project:
1.

The handbook may be altered for use with the

Macintosh or Claris Works software and earlier
versions of Microsoft Office software.

2.

The handbook could be modified to meet the needs
of teachers teaching higher education.

Definition of Terms

The following terms are defined as they apply to the
proj ect.
Application program - Computer program that accomplishes a

specific task, such as word processing or processing
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of payroll data (California Department of Education,

2001).
Database - A file created by a database manager that
contains a collection of information organized into
records, each of which contains labeled categories

called fields

(Rutkosky, 2002).

Desktop publishing - The use of computer software to
integrate text with charts and pictures and to

design, display, and print high-quality documents

comparable to typeset print

(California Department of

Education, 2001).

Hardware - A computer or other piece of technological
equipment

(California Department of Education, 2001).

Knowledge Worker - a person who works with and produces
information as a project

(Haag, 2002) .

Internet - a vast network of computers that connects
millions of people all over the world (Haag, 2002) .

Mail Merge - The merging of database information (such as
names and addresses) with a letter template in a word

processor, in order to create personalized letters
(Rutkosky, 2 0 02) .

Scanner - A device used to translate print media into
computer language so that a document can be viewed
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and later read on the computer screen (California
Department of Education, 2001).
Software - The programs used with a computer to perform
tasks such as word processing or accounting. The term
was coined to contrast with hardware of a computer

system (California Department of Education, 2001).

Spreadsheet - A computer program that turns a computer
terminal into a huge ledger sheet with large columns

and rows of numbers that change according to
parameters determined by the user (California

Department of Education, 2001).

Storage - Device, or part of a device. That can retain
data; memory (California Department of Education,

2001).

Word processing - The production of typewritten documents
through automated and usually computerized typing and

text-editing equipment

(California Department of

Education, 2001).

Organization of the Thesis
The thesis portion of the project was divided into
four chapters. The first chapter provides an introduction
to the context of the problem, purpose of the project,

significance of the project, limitations and delimitations
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and definitions of terms. Chapter Two consists of a review
of relevant literature. Chapter Three documents the- steps

used in developing the project. Chapter Four presents the

conclusions and recommendations drawn from the development
of the project. The Appendices for the project consists

of: Appendix A Professional Teachers' Proficiency in
Computer-Based Technology; Appendix B Educator Projects

using Microsoft Office XP. Finally, the Project
references.
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CHAPTER TWO

REVIEW OF THE LITERATURE

Introduction

Chapter Two consists of a discussion of the relevant
literature. The relevant literature reviewed was separated
into nine sections. Specifically, the first section ■'

consists of literature providing a framework for the

remaining sections. Section two, Teachers' Comfort Level,
consists of literature covering teachers' comfort level

utilizing technology. Section three, Teacher Training,
consists of literature covering teacher training in
technology. Section four, Types of Technology Use,

consists of literature covering the types of technology in

use by teachers. Section five, Teaching Experience,
consists of literature covering teacher experience.

Section six, Access and Usage, consists of literature
covering access and usage of technology in classrooms.

Section seven consists of literature covering the
obstacles to utilizing computer technology and

professional development. Section eight, Obstacles to

Utilizing Computer Technology and Professional
Development, consists of literature covering computer

system requirements. Section nine, Computer System
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Requirements, consists of literature outlines the matrix
of professional teacher's proficiency in computer-based

technology.

Background
Teachers face many challenges in successfully

performing their job responsibilities. School
administrators and the media are continuously comparing
the test scores of U.S. students with those achieved by
students from other countries. The pressure U.S. teachers

are experiencing to improve student test scores is

significant. One tool readily available or soon to be
available to all teachers is a computer. While teachers
may not feel they have sufficient hardware and software to
integrate the delivery of instruction using computer

technology, teachers should all be using such to support

the performance of their job responsibilities

(Trotter

2002 p. 41). And while the problems in our classrooms

today are too severe to be solved with computer technology
alone, effectively training our teachers and deploying and
employing the computer resources can go a long way in

enabling teachers become more productive in performing
their administrative responsibilities,
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thereby freeing up

time that can be redirected to the instruction side of

there jobs

(Wilkes 2000 p. 8) .

According to John P. Bailey, the director of
education technology for the Department of Education,

can have the fastest Internet connection,

"you

the best

computer, and the most sophisticated curriculum software,

but if teachers aren't trained in how to use it,
going to make a difference in the classroom"

it's not

(Skinner,

2002, p. 54). The remainder of the literature review

presents some of the more important reasons noted for

teachers not integrating computer technology to improve
their productivity.

Teachers' Comfort Level

There have been numerous research studies that reveal
some common results as to why teachers are not jumping at

the opportunity to integrate computer technology into

their classrooms. The first observation noted in a few
studies on teacher comfort with computer technology found
that a teachers' comfort level relates directly to the

teachers use of technology in the classroom (Milbrath,

2000; Seamon, 2001 a and b). The more comfortable the
teacher is with the using computer technology the more

likely they will integrate it into their classroom
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(Mulqueen, 2001; Schwab, 2001). In a study conducted in
1995 of 72 elementary teachers,

it was found that 60% of

the teachers avoided using computers and treated computer

lab visits as an aimless activity (Milbrath,
Dupagne and Krendl

(1992)

2000) .

stated that "teachers who have

had computer training are more likely to show positive
attitudes toward computer use in the classroom"

(p. 423),

while those who had no prior experience exhibited high
anxiety towards using computer,

(Liu et al.,

1992). To

overcome these barriers, it is essential that teachers be
provided adequate computer training to ensure these new
tools are effectively employed.-

According to a 1999 National Center for Education

Statistics study on teacher quality, it was reported that
only 20% of all teachers feel "very well prepared" to

integrate technology into their teaching

(Hasselbring et

al., 2000). This suggests that while a classroom can be
outfitted with the latest and greatest technology,

it is

unlikely that it will be used if the teacher is not
trained or is uncomfortable with how it can be effectively
and efficiently employed to aid in their teaching.
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Teacher Training
Teacher Training is important in the successful

integration of technology in the classroom, and yet, most

teachers said they and not received the technology
training necessary to incorporate technology in their

classrooms

(Jones, 2001). Since very few teachers entering

the profession prior to the mid-1980s received instruction
that included the use of software applications and

computer hardware, district training efforts tend to be

focused more on how to use the hardware,

instead of

covering methodology on how to integrate technology into
their classrooms

(Hasselbring et al., 2000) . Training

focused primarily on the hardware leaves a significant
void in rounding out a teacher's skills and information on
how computer technology can be integrated into their

profession to enhance their personal productivity and
expand their instruction methods. To maximize the

effectiveness of the training, it should be aligned with
the curriculum and be relevant to what teachers are doing
in their classrooms

(Trotter,

1999) .

The more training the teacher has, the more likely

the teacher will use technology in the classroom (Milbrath

2000; Mulqueen, 2001; Schnorr, English, Armani,

& McCabe

1999; Seamon, 2001 a and b). Along with the ideas of
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training it was also found that there are better forms of
training. In-service and peer tutoring or teaching worked
better to inform the teachers than general college classes
(Schnorr et al., 2001; Mulqueen, 2001) . The types of

teacher training available offered the teacher instruction
in the area they felt necessary and let the teacher

customize their learning experience.
Some have suggested that teachers shy away from using
computers in the classroom because computers cause them to

question their existence as educators

(Falk,

1987). For

teachers to use computer technology, they must view

technology as a tool to make their jobs easier. Teachers
can also benefit from role models, encouragement, ongoing
training,

time to explore the capabilities of computer

technology, and a supportive environment

(Hope, 1997) .

Teachers need to have sufficient time to practice using
computers and have the technical resources available to

answer their questions.

Types of Technology Use

Several articles have demonstrated the need for
increasing technology available to teachers and students
in the classroom (Nelson 2000; Junui, 2001; Molenda,

2002). Several authors have suggested using computer
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technology and software in the classroom as a means of
delivery different from the normal and more common lecture

(Jones, 2001; Junui, 2001). There is an abundance of

technology software available to help out in classrooms.

Teaching Experience
The more teaching experience educators have the less

likely they are to integrate technology into their
classroom. Experienced teachers seem to lack formal

knowledge and do not feel comfortable using technology. On
the other hand, teachers entering the education field with

recent degrees seem better prepared and more comfortable
(Anonymous, 2001; Jones, 2 001; Molenda,

2 0 02) .

Access and Usage

Teachers use computers very little on a day-to-day
basis. Access to computers is the biggest barrier for

teachers. There are either scheduling conflicts to use
labs or not enough computers in classrooms

(Anonymous

2001; Molenda, 2002). Further studies have found that uses
of technology are limited by both the quantity and quality

of the hardware and software available in the schools.

While the number of computers in schools has increased in

recent years, the inequitable distribution of hardware and
software is a problem, often referred to as the "digital
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divide." The U.S. Department of Education found in 1998

that students from more affluent schools as measured by

their eligibility for federally subsidized lunches are
much more likely to be technologically rich as compared to

schools with high minority enrollments and high rate of
federally subsidized lunches

(Hasselbring et al., 2000) .

Obstacles to Utilizing Computer
Technology and Professional
Development
In his book, The Road Ahead, Bill Gates states,

"One

thing is clear. We don't have the option of turning away
from the future. No one gets to vote on whether technology

is going to change our lives"

(1995, p. 74). This

statement is as true for educators as it is for an

automobile mechanic working on today's sophisticated
computerized cars. Computer technology is readily

available in our schools, which is forcing teachers to
rethink and reengineer their teaching practices. And while

the many teachers recognize that they live in a world in
which highly refined computer skills offer increased

opportunities for accessing new ideas and information,

few

believe that they have the skills that are necessary to
use these tools effectively or to teach their students to
do so

(Hasselbring et al., 2000). In a study that examined
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rural teachers

(Matthews,

1998),

it was reported that more

than one half of the teachers surveys perceived themselves
as novices in all aspects of technological use, with less

than one half never actually using computer technology for

instructional purposes. The data from this study also
suggest that the teachers are not likely to use these

resources to increase their personal productivity or to

support their own professional development.
Several reports cite equipment, software, time and

training as the most common obstacles to the integration
of computer technology, the elimination of these barriers

does not necessarily facility a smooth transition to
computer technology use by classroom teachers

(Hall,

1997). A study was designed to train and support
school-based teams of teachers and administrators to use

computer technology, and to further remove all known

obstacles to the integration of computer technology in
five elementary schools. In this situation, the project

coordinators emphasized integrating the technology to

support higher level thinking skills. The project appeared
to be successful in years one and two, but in the third

year when the curriculum was changed, the teachers and

administrators felt very constrained to use the new
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techniques, and in fact many reverted back to their old

teaching methods

(Hasselbring et al., 2000).

In another study conducted in 1997 of 298 teachers,

it was found that, on average, teachers spend between one
to eight hours per year of professional development time

on computer technology training. This study further noted
that teachers felt that there was

(a)

insufficient time

for experimenting with computer technology and (b)
problems with the quality and timing of the training,

(c)

the length of time that elapsed between training and the
acquisition of technology, and (d) problems of

malfunctioning computer technology (National Council for
the Accreditation of Teacher Education,

1997). These

studies clearly suggest that the time, quality and scope
of computer technology related training provided to

teachers significantly impact the type and degree to which
computer technology play's a role in the classroom today.

Computer System Requirements
It was reported that the ratio of students to
computers dropped below 6 to 1

(Hasselbring et al., 2000).

However, upon taking a closer look into this fact, one

would find that in this count is computer equipment that

is outdated and unable to perform more than simple word
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processing type functions. The equipment being referred to
are old Apple II and 386 computers, which are not powerful
enough to function in today's high functioning computer

environment. School districts in California are given the
latitude to establish their own hardware and software
standards for new purchases

(California Department of

Education, 2001). At a minimum, new equipment purchase
standards should consist of the following:

•

300 MHz or faster

•

128 MB or more for Windows 2000 or 256 MB or

more for Windows XP operating system
•

4 GB or larger hard drive

•

lOx or faster CD-ROM drive

•

High resolution graphics adapter with at least 2

MB video RAM, supporting at least 24-bit color
at 800 X 600 resolution.

•

Sound support, including speakers and headphones

•

56kbps V.90 modem

•

Bundled software, which includes Microsoft
office suite.
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Matrix of Professional Teachers'
Proficiency in Computer-Based
Technology

Appendix A contains the matrix adopted by the
California State Board of Education in January 2001
describing the professional teachers proficiency in
computer-based technology (Appendix A).

Summary
Reviews of research on in-service teacher
professional development agreed that the components of

time, sufficient hardware and software,

formalized

instruction, training curriculum, support, and teacher

motivation and commitment play a vital role in creasing
the effective integration of technology into the

classroom, and allowing for the teacher to improve their

personal productivity by utilizing the technology in a
supportive role.
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CHAPTER THREE
METHODOLOGY

Introduction

Chapter Three documents the steps used in developing
the project. Specifically,

the population served by the

curriculum is presented. Next, the resources and content
validation is discussed. Finally, the design of the

curriculum is outlined.

Population Served

The handbook was intended for use primarily by
teachers who are not presently using the computer to

improve their personal productivity. The handbook is also
suitable for implementation and adoption by any individual
who has a specific application to utilize the projects
demonstrated in the handbook.

Handbook Development

Handbook Resources and Content Validation

The source of validation for the handbook was from
many sources including Microsoft Office textbooks, general

computing textbooks, and an advisory group. The advisory

group consists of the following:
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•

Second grade teacher who is over 50 years of age

•

Third grade teacher who is over 30 years of age

•

Seventh grade English teacher who is 30 years of

age
•

Special education teacher who is between 40 and
50 years of age

•

Technical writer who prepares technical computer

user documentation as his primary occupation.

Handbook Design

Research on contextual learning gives a format for
contextual based lesson plans. According to the Horizons

Electronic Lesson Plan Resource web page,

lesson plans

should include the following:
•

The overview should provide the title of the
lesson, recommended grade level, recommended

timeframe, subject areas, and the objectives of
the lesson.

•

A brief introduction of what the lesson is about
and how the lesson relates to students' prior

knowledge.
•

The content standards for the lessons presented
in the project section of the thesis will be

from the Secretary's Commission on Achieving
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Necessary Skills Course Competencies and the
California State's Professional Teachers'
Proficiency in Computer-Based Technology

requirements as presented in the literature
review.

•

The lesson section included the concepts to be

taught, the procedures for teaching these
concepts, the materials needed during the lesson

and how the student's performance will be

measured to ensure they mastered the lesson
obj ectives.

Summary

The methodology section of the thesis addressed the
population served and the design of the curriculum

presented in the handbook. The lesson plan format was
based on research on contextual learning.

23

CHAPTER FOUR
CONCLUSIONS AND RECOMMENDATIONS

Introduction
Included in Chapter Four was a presentation of the

conclusions gleamed as a result of completing the project.
Further, the recommendations extracted from the project-

are presented. Lastly, the Chapter concludes with a
summary.

Conclusions

The conclusions extracted from the project follows.
1.

Based on the review of published books and
discussion with experts, the current handbooks
in the marketplace, developed specifically for
teachers, do not incorporate the most recent

capabilities of Microsoft Office XP.
2.

A handbook needs to be developed that helps
educators utilize the hardware and software

readily available which will enable teachers to

improve their productivity.
3.

Based on the review of literature and
discussions with various K-12 teachers,

they are

not utilizing the software and hardware
available to them as they are not familiar
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enough with the software and how it can be
applied in the performance of their job

responsibilities.

Recommendations

The recommendations resulting from the project follows.
1.

It was recommended that a handbook for teachers
be developed with detailed,

step-by-step

instructions for utilizing the Microsoft Suite
of applications, XP version,

to assist the

teachers in increasing their productivity and
enhancing the learning environment for their

students.
2.

Create sample projects which are geared
specifically for teachers and the type of

projects that would be most beneficial for

teachers.

Summary

Chapter Four reviewed the conclusions extracted from
the project. Lastly, the recommendations derived from the

project were presented.
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APPENDIX A

PROFESSIONAL TEACHERS'

PROFICIENCY IN COMPUTER-BASED
TECHNOLOGY

26

Professional Teachers’ Proficiency in Computer-Based Technology
Factors to
Consider
Communicates
through a variety
of electronic media

Professional Profile

•

•

Interacts and
collaborates with
others using
computer-based
collaborative tools

•

•

Collaborates with
other teachers,
mentors,
librarians,
resource
specialist, and
other experts to
support
technologyenhanced
curriculum

•

•

Performance Indicators

Identifies, selects, and
uses digital
communication tools
appropriately.
Uses digital tools to
communicate with
students, parents, and
community members to
enhance management
and learning.

•

Supports student
learning through
collaboration with
parents, subject matter
experts, educators, and
others using digital tools
Participates in
professional growth
activities by using digital
communication tools.

•

Uses digital
communication tools to
work with educators and
subject matter experts to
design classroom
activities to support
student learning
Seeks out and draws
upon the expertise of
others to support the
learning process and
technology-enhanced
curriculum.
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•

•

•

•

Evidence of the use of a
variety of communication
tools based on resources
available (e.g., telephone,
e-mail, fax, listserv or Web
page)
Evidence of management
of information using
technology to increase
communication, (e.g., Web
pages, voice mail,
homework hotlines
Evidence of sustained
communication with
parents, students, and/or
colleagues through mailing
lists, video conferencing,
online staff development,
shared network folders,
etc.
Lesson/activity plans are
designed collaboratively
using appropriate
communication tools as a
medium (e.g., e-mail,
listserv, shared network
folders, mailing lists, video
conferences, etc.).
Student work that
exemplifies evidence of
active collaboration with
outside experts
Interdisciplinary lessons
and cross grade-level
projects (see also
Planning, Designing, and
Implementing Learning
Experiences)

Factors to
Consider
Continues to sitebased planning or
local decision
making regarding
the use of
technology and
acquisition of
technological
resources

Professional Profile

•

•

•

Demonstrates
competence in
evaluating the
authenticity,
reliability, and bias
of data gathered:
determines
outcomes and
evaluates the
success or
effectiveness of
the process used

•

•

•

Provides leadership by
participating in school
wide decision-making
and learning activities
that support learning
through the use of
technology
Actively contributes to the
development or updating
of site or district-based
technology plans
Explores new
technologies and
recommends innovative
educational applications
appropriate to the
curricular needs of the
students and site
Evaluates authenticity,
accuracy, reliability, and
bias of resources to be
used in the planning and
designing of instructional
activities
Identifies the process
used to evaluate data
and determines the
success or effectiveness
of that process
Applies information
literacy competencies in
professional practice
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Performance Indicators

•

•

•

•

•

Participation in grade-level
or department activities to
develop a school site
technology plan
Pursues continuing
education (e.g.,
educational technology,
conference attendance,
curriculum integration,
online courses workshops)
Evidence of active
participation in the site or
district decision-making
process regarding the use
of acquisition of
technology (e.g., gradelevel technology
committee, technology
planning)
Research on curriculum
resources incorporates
multiple references from a
variety of credible
electronic and traditional
sources
Evidence of self-reflection
and evaluation on the
outcome and success of
the process used through
anecdotal records, self
reflections, journals, and
lesson plan revisions

Factors to
Consider
Optimizes lessons
based upon
technological
resources
available in a
variety of learning
locations

•

•

•

Designs, adapts,
and uses lessons
that develop
student
Information literacy
and problem
solving skills as
tools for lifelong
learning

Performance Indicators

Professional Profile

•

•

•

Applies best practices
and research findings on
the use of technology in
managing resources for
specific student
populations
Analyzes the needs of
students and organizes
appropriate and available
technological resources
for curricular applications
Establishes technology
procedures and routines
that engage all students
in a variety of learning
environments

Implements lessons that
engage students in
evaluating information,
problem solving, and
critical thinking to make
subject matter
meaningful
Facilities activities that
engage students to
become self-directed
learners through effective
use of technology aligned
with curriculum standards
Incorporates lessons
using appropriate
technological and
traditional tools for
student research, data
gathering, analysis, and
presentation
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•

•

•

•

•

•

•

Classroom activities reflect
the availability of
technology tools and
resources at site,
community, and home
Lesson activities use ~
appropriate technology
resources based upon
specific student needs ,
(e.g., drill and practice,
simulation, video-based
instruction)
Lesson activities reflect
access to a variety of
learning locations (e.g.,
one computer room,
computer lab, multiple
workstations in a room,
and portable technologies)
Student research projects
incorporate multiple
references from a variety
of credible electronic and
traditional sources
Student methods of
utilizing valid information
are analyzed for success
(e.g., rubrics, student
reflection, and/or
bibliographic cross
referencing)
Evidence that
improvements to future
student activities are
planned
Lesson plans indicate
activities to maxirnize
student learning by
matching the most
appropriate technology
resources to instructional
and learner needs

Factors to
Consider
Creates or makes
•
use of learning
environments
inside the class
room, as well as in •
library media
center or computer
labs, that promote
the effective use of
technology aligned
•
with curriculum

•

Uses technology in
lessons to
increase each
student’s ability to
plan, locate,
evaluate, select,
and use
information to
solve problems
and draw
conclusions

•

•

•

•

Professional Profile

Selects appropriate
technology that supports
state academic content
standards
Implements effective
classroom management
techniques using
technology in a variety of
educational settings
Employs a variety of
technology-based
instructional strategies to
enhance learning (e.g.,
direct, cooperative,
individual, etc.)
Supports varying learning
styles and modalities by
integrating a variety of
technological resources
in lesson design for all
students
Engages students in the
process of planning,
locating, and evaluating
information obtained by
using technology
Designs technologyinfused lessons to
increase student’s
critical-thinking skills
Facilitates technologyinfused experiences that
promote autonomy,
interaction, and choice
Incorporates instructional
strategies to develop
student skills for
assessing validity and
reliability of information
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Performance Indicators

•

•

•

•

•

•

Sample technologicalintegrated lessons are
clearly aligned with state
academic content
standards
Evidence of lessons that
provide for equal access to
technological resources for
all students in a variety of
locations
Sample technologyintegrated lessons use
technology appropriately.

Evidence of lessons that
provide engaging activities
for students to evaluate
information, solve
problems, and draw
conclusions
Student projects
demonstrate student’s
increased ability to plan in
order to select and use
information
Models the use of
technology to plan
activities for solving
problems and drawing
conclusions

Factors to
Consider
Demonstrates
knowledge and
understanding of
the legal and
ethical issues
concerned with the
use of computerbased technology

Uses computer
applications to
manipulate and
analyze data

Professional Profile
•

•

•

•

Translates the school’s
acceptable-use policy
(AUP) into
understandable rules and
procedures for students
Demonstrates and
advocates legal and
ethical behaviors for
students and colleagues
regarding the use of
technology and
information

Collects, organizes, and
analyzes data using
technology for the
purpose of managing
resources, learning
environments, and
project design
Uses technology to
collect and analyze data
for school instructional
planning

Performance Indicators
•

•

•

•

•

•

•

•
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Models, teaches, and
reinforces intellectual
property rights and
acceptable-use policies
Evidence that students are
following the acceptableuse policy
Evidence of lessons that
include copyright and
policy citations
Student reports include
appropriate bibliographic
information
Evidence of the use of a
gradebook spreadsheet or
database program to
record and report student
progress
Instruction is modified
based on the analysis of
student mastery of data by
using district-adapted
student information system
Evidence of the use of
assessment tools and
strategies to evaluate
student activities
Customized documents for
school planning use
technology tools

Factors to
Consider
Uses technology
to assess student
learning and
provide feedback
to students and
parents

•

•

•

•

Frequently
monitors and
reflects upon the
results of using
technology in
instruction and
adapts lessons
accordingly

Performance Indicators

Professional Profile

•

•

•

Devises project
assessments that allow
students and parents to
monitor progress and
adapt educational
activities appropriately
Produces individualized
learning reports of
students
Shares learning reports
with students and parents
to provide feedback to
improve purposeful
student engagement in
learning
Collects, interprets, and
reports student
performance data using
technology
Analyzes the effects of
technology integration on
student learning and
modifies lessons to better
meet curricular goals
Uses technology tools to
collect and analyze
student data to effectively
manage instruction and
classroom management
Analyzes best practices
and research findings on
the use of technology
and designs lessons
accordingly.

(California Department of Education, 2001)
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•

•

•

•

•

•

Evidence of the use of
electronic means to collect
student data (e.g., gradebooks, web-based testing,
computer-aided
instruction, etc.)
Presentations are
produced for a variety of
audiences to illustrate
student performance
Evidence of the use of
technology to create
individual learning reports
for parents and students

Plans identify, manage,
and organize resources
available for appropriate
student use
Portfolio of progressive
lesson plans indicates
more effective use of
technology in alignment of
best practices and
research findings
Evidence of reflection on
the process of monitoring,
analyzing, and modifying
the effective use of
technology in lessons

APPENDIX B

EDUCATOR PROJECT USING
MICROSOFT OFFICE XP
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using Microsoft Office XP
By Darcy Coulter
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DISCLAIMER
The references provided at the end of the handbook are not cited within

the handbook as the references were used to enhance the author's

knowledge of the subject.
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Lesson Plan Project
It is imperative to every teacher’s success that you have an organized method
for preparing and storing the lesson plans. In this lesson plan, you will master
the skills needed to:

Create file folders on your PC

Create a lesson plan template

The steps are as follows:

Part 1 - Creating File Folders
1. Open MS Word and create the document you need to store.
2. Save the document by clicking on File from the menu, and click on Save.
From the dialogue box,
click on the
Tools’
file folder
button. This
button
Create New Folder
allows you
to create a
new folder.
lx

.£|xi
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Save

Cancel

3. When the new folder dialogue box appears, type the folder name. In this
case, name the folder Lesson Plans
and click OK.

Next, you may want to create folder for each subject or course you
will be creating lesson plan for. To do this, you need to open the
folder Lesson Plan and repeat step 3 until you have created the
desired folders.
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Part 2 - Creating a Lesson Plan
1. Open MS Word to a blank document.
2. From the Format menu, choose Font. Change the font type to Arial, font
style to bold, and the font size to 16.
Type Lesson Plan Template. Change
the font settings back to the original
settings.

Highlight the title text and click Align
Center from the format toolbar.
Effects — < —

iS| Projects - Microsoft Word
f File

£<$t

Vtsw

Insert

Format

say -

j
Tools

Tebte

ygntfew

Help

I

Steffi^

j
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P,Snfcettvough
Pj^ubie strikethrough

. P Superscript

7 ‘2 e Hb z s js
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* '■ t-2s’ ? 1^!*-lBcer*crl>

P Subscript

Pyhadow
P fii/ime
• P gmboss
P, Engrave

P, Smalt caps:
P.gieafK

rt

I Preview

the
The a a TrueType foni. Thtt few wiS ba u«d on both p«ntv and screen.

fiefauk..:

3. Adjust the side, top and bottom margins of your lesson plan, by clicking on
File menu and selecting Page Setup, and then click Margins tab. The
Page Setup dialogue box below appears to allow
you to make the adjustments.
Change all margin settings to 1” for the entire
document by either using the up/down arrows or
typing directly in the white box
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4. Using the table feature
of MS Word, we will
create the lesson plan
template. From the
Table menu, choose
Insert, Table.
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4. At the Insert Table dialogue box, change the number of columns to three
and verify that the rows are two. Use the
up/down arrows to change the number, or type
directly over the number appearing in the box.
Click OK. The grid below will appear on your
screen.
| Insert Table

771

Table size

Numberof columns;

.

Number of lows:

AutoR behavior

— —

(♦/Ftxed column wcfth;

I3

±j'

|2

±1

JAuto

±1

-

OAutcQt to contents

OAutcFi to wrisksw

Table style: TableGid

In the grid, type Subject, Unit Title, Lesson
Title in the first row and Student Grade, Lesson
| |i
Timeframe and Instructor Name. Be sure to
highlight the typed text and click Bold from the Format toolbar to make
your titles bold.
fjRemember dimensions for new tables
J:

Your lesson plan template should look like this.

LESSONPLAN-TEMPLATEfl
Subjects

UnlbTitles

Grades

LessonH
Timeframes

Lesson-fl
Titles
lnstructor-11
Names

11
II
II

H
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OK

Cancel

,_l

5. Add eight more rows, one column each to your table which will contain
the other areas needed to complete your lesson plan template. Again, you
may want to
bold your titles.
LESSON PLAN TEMPLATE
Your lesson
Subject:
UnitTitle:
Lesson
plan template
Title:
Grade:
Lesson
Instructor
should now
Timeframe:
Name:
Objectives:
look like this.
Teaching Methods/Techniques
Introduction:
Content:
Summary:
Evaluation:
Assignments:
Resources Required:

As you begin to use your lesson plan template, the cells in the table
will adjust to fit the text.
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Sample Lesson Plan Template

LESSON PLAN TEMPLATE
Unit Title:
Lesson Title:
Subject:
Social Science & Health Unit 2
Multicultural Cuisine
Grade:
Instructor Name:
Lesson Timeframe:
7th Grade
Paced over 2 weeks
Brook Sikora
Objectives: By the end olF this lesson, students will be able to: ■ .
.
Discuss exchanges of plants, animals, and culture among various
continents in the 1 (5th century
Explore a wide vari ety of healthy foods consumed during this time
period on the contiinents studied.
' .
Teaching Methods/Techniques:
Demonstration/lllustrated talk
Directed discovery
Interactive/Cooperative groups
Display
Oral presentations
Introduction: Ask students to list favorite foods, and why they like them.
Discuss the origins of these foods. Teacher will have some sample foods for
students to taste.
Content: Content will include all the aspects of the unit that you plan on
covering.
Summary: This will contain a description of the wrap up activities including
reviewing for the test.
Evaluation: Students will complete two quizzes and a unit test.
Assignments: Students will be required to prepare and deliver a
presentation to the other students on the food/dish they prepared.
Resources Required: Textbooks, foods to sample, handouts, overheads
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Mail Merge Project
As a teacher, you will need to periodically correspond with the parents of your
students. Some typically events which would create a need for
correspondence are:

Back to School Night
Holiday parties
Field Trips
Parent - Teacher Conferences
End of School Year Calendar
In this project, you will master the skills needed to:
Create a letter/invitation inviting the parents to Back to School
Night
^Create a mailing list/database of the parents

Merge the two documents/files so that individualized letters can
be created for each parent.

The steps are as follows:

Part 1 - Creating the Letter/invitation
1. Open MS Word to a blank document.
2. Click on the Center Alignment icon in the format toolbar at the top of
the screen.
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3. Click Format in the menu bar, and then click on Font to develop your
letterhead.

Here is the
“Font"
Dialogue Box

4. Scroll through the fonts and click on a decorative font you like. In the
example, the “Tahoma” font is used.

5. Click Bold and Font point size of 20.

6. Click OK. Type the name of your institution. In the example, we are
typing “The Children’s Center.”
7. Click Format menu, then Font and select a different decorative font. In
the example, the “News Gothic” is used. Also, if you are using a color
printer and want to add color to your font, you will see in the Font
dialogue box, you have this option. Black is the default color or
“automatic.”
8. Type your school address, hit enter and type the school city, state and
zip. Hit enter.
9. Click on 7” for italics icon on the Format toolbar and type your
telephone number. Click on “I” again to turn off this feature.
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10. Hit enter and click the Align Left icon in the Format toolbar at the top
of the screen.
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11. Hit enter three more times to give three lines of space between your
school’s address information and the date.
.!
12. Go to the Font box in the Format toolbar and click on the List Arrow.
Select the “Arial” font from the list, or another of your choosing.
In the box, directly to the right of the
Font box, select the list arrow and a
Font point size of “12.”

13. Click Insert on the Menu Bar, and then
click on Date and Time.
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14. Hit enter four times to put four lines between the date and the parents
address information.
15. Save and name your document as “BacktoSchool Form Ltr.” You will
want to do this often so you don’t loose your work. To save the letter
click File, Save. Type the name of the letter into the dialogue box and
click on Save.

16. Click enter four times to create four lines. One line will be used for the
Address Block of information during the merge. Also, the greeting line
will be created during the merge, so we will need an additional line for
this information. Typically, there are two lines between the address
information and the greeting line and one line between the greeting line
and the first line of the letter.

17. Click enter two more lines. Begin typing the body of the letter. Below,
you will find the body of the example letter including the salutation.
I am writing today to let you know that “Back to School” night will be held on
Wednesday, September 15, 2004. We will have two sessions in order to
accommodate parents with more than one student attending the school. The first
session begins at 7:00 p.m. and the second session begins at 7:45 p.m.

During our time together, I will review the learning objectives for the year, and plan to
share my educational philosophy. Since I know many of you will want to get involved
' by assisting in the classroom or with the parent support group, twill have information
on both these areas as well.
• In closing, I am really looking forward to working with this year, and I hope you will be
able to join us to learn more about the educational journey we just embarked upon.
Best regards,

Your Name

You will notice that in the closing paragraph, between the words
“with” and “this” a space has intentionally been inserted as we will
be inserting the students name iri this spot during the mail merge.
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18. To adjust the side, top and bottom margins of your document, click on
File menu and choose Page Setup, and then click Margins tab. The
Page Setup dialogue box below
appears to allow you to make the
adjustments.
”3

Change all margin settings to 1” for the
entire document by either using the
up/down arrows or typing directly in the
white box

ED
■ Pages .------------ Muitpfe pages;;
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Part 2 - Create Mail List/Database with Excel
1. Open MS Excel to a blank spreadsheet.
2. In cell A1, type “Last Name.” In cell B1, type “First Name.” Continue as
follows:
A1 = Last Name
B1 = First Name
C1 = Students Name
D1 = Address
E1 = City
F1 = State
G1 = Zip
H1 = Phone Number
Here is a sample of how your spreadsheet should appear.
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3. To make the column headings bold, highlight the entire row by placing
your mouse directly over the number 1 and press the left mouse button.
This highlights the first row. Next, click the Bold icon and the Align
Center icon on the Format toolbar.
Miciosoh Excel,

;□ o o a a a o
£fe gdst View Insert Format Tools gata ggndow
] □ ssas3q sa“v i
a -<*

’n

[ La -u
iAriS
™

% "j' 3

I

... :

A
Last

-j.: B
i

First

11..... :....

C

j'

I

l

•..........

‘

47

Stale
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4. Move the cursor into cell B1 and begin keying the information on your
first student. Continue until you have 5 students in your Excel
database. Below, you will see the example database with five student
records.
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You can quickly see that not all the data in each cell is visible. To
correct this, place your courser on the line between the “B” and “C.”
You should see a double arrow. Click the left mouse button twice
quickly and Excel will automatically adjust the column width to the data.
Continue this
process for
;i D a? a -j a ’ £S Li
fft «.
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.
any other
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sa 71 «j ’
columns
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Al Kendrick
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(Riverside rCA
picture of the
(Riverside
(CA
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B

Window

C
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5. Save and name your Excel database as “ClassRoster 2002-03.” You
will want to do this often so you don’t loose your work. To save the
database click File, Save. Type the name of the database into the
dialogue box and click on Save.

6. Close the file by selecting File from the Menu toolbar and click on
Close. Next, exit Excel by clicking File from the Menu toolbar and click
Exit. A shortcut method is to click the “X” in the upper right hand side of
your screen.
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Part 3 - Merge Letter with Excel Database
1. Open MS Word and the letter you created in Part 1.
2. Click Tools, Letters and Mailings, and Mail Merge.
insert
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Track Changes
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Mas!Merge Wizard..,
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2. You will now notice that the Task Pane automatically came up on the
right hand side of your screen.
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CEnvelopes
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We will now cove the six steps to performing the mail merge. Make
sure the letter you created in Part 1 is open when you complete step 1.

2. MS Word has determined that we are working on a.Letter created in
Part 1; hence, the bubble beside the word ‘Letters’ is highlighted.

ain

3. Click on Next: Starting document to continue.
SI
Select document type

__

Vvh-it type of dottimeht are you
worteigon?

O E-masl messages.
Envelopes

4. Next, we need to select the starting document.
The default is to Use the current document.
This is the option we will select.

0 labels
^Directory

Setect starting document...
How do you wait to set up your
letters?

Send letters to a group of people.
You can personalize the tetter that
each person receives.

{•? Use the current dccumsnt
Q Start from a template

0 Start from e>dsong docurient .

Use the currentdocument.... ....... ,
Startfromthe document shovw
here and use the Mai Marge wizard
to add recpient Information.

5. Next, we will need to select
our recipients. We will use
the default Use an existing
list since we created our list
in Excel.
Select.redptents

„ „'

w

<?) Use an existing list

“ Gck ftfe>i to continue.

JLj Step lofft

O Select from OutLok contacts

t£> Next; Startira document

Next

0 Type a new list

step 1

Use on existing Hst

.

Use names and addresses from a
fie or a database.

O Browse...
cdLretipier

Jlj Step 2 of6
0,s

. ....
•
Nsxt:Select recipients
Previous:Selectdocument type

Step3ofji________________
f*s-'

j

jjF+s

50

Wfteyour Liter

Previous: Starting document .

We now
need to
click on
Browse to
locate our
database
file.

6. Browse your system until you locate your database file. Here is a
picture of the database created in Part 2.
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7. On the database we created, we saved our data on sheet 1. Given this,
select OK and you will see your data pop up.
De&rgtpnj.tflodiftM

. J Created,.

1/20/03 6:01:04 PM
1/20/03 6:01:04 PM
1/20/036:01:04 PM

_
H5hect2$
E!Sbeet3$

. ’ Type. ,

1/20/03 6:01:04 PM TABLE
1/20/03 6:01:04 PM TABLE
l/20/036:01:04PM TABLE

Jil

was
Phrst row cf cteta cwtdns cdurnn headers:

8. You may also want to follow the instructions for sorting the data in
alphabetical order. Next, select OK to proceed.
>i
\ ‘
'6W 0fl
Mail Merge Recipients

; To sort the list, d«k the appropriate cobrn heading, To narrow down the recipients dspteyed by a
specftc criteria, such as by city, click the arrow next to the coluiw hearing, Use the check boxes or
• 'buttons to add'orremove recipients from the mail merge,
v^sto* recipients:

j>7* Lact| 1 F»d | wf AdAest "1"'^ C^y. ). r! z"!^)Pho h -r.1 St

i Jones
; Karen&... |?312E!mA...
S3 : GoWsW.„ j Maiiyn L.. ; 123Meptew...

firveradejCA
Riverside 1 CA

0J Binghan ? Beth&P... = S75MagnqL. Rrverstde J CA
£Q Rosen
? Harry &7.. j_4285 Danye... ’ Riverside HZA

^|r~—
i Select Ml
&nd„

dear filf:

Refresh

5£aWate
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132502
192503
i 9250S
132504

I (909)78...
! (909)70..
1(909)68.7
I (903)

I
i
I
i

Laura
Warier
Teddy
Brook’

Click Next in the Task Pane area to proceed to the next step. Now, we
will need to add recipient information to our letter.

First, move your cursor to the location
where you want the address block to
appear.

; Specify address elements -■

-

% insert recipient’s name m tfas format:

Tj

'

Mr.

Josh end Cynthia

Scroll through the list to determine the
format you would like the parent’s
names to appear.
You will also want to de-select the
Insert company name as that is not
necessary for this application.

Next, select OK. You will notice that
the words ««AddressBlock»»now
appear where the address information
will be placed during the merge.

: [7 Insert posts! address:
t

(• ijevei indude the co wby/ragtt, in the address
'<

C Always snc’ude the countoy/re^on in the address

,

C Qtiiy hciude the country/retfn if d/ferent than:

Prevew
Josh and Cynthia RandaS
1 Airport Way
KtCyHa^NC 27700

’l^tchFiekJs, , |

p

OK

Js

Cancel

j

10. Next, we will need to format the Greeting Line. To do this, move your
ns
cursor to the space just in front of the
fireetirfg toe format:
colon. Click on Greeting Line in the
|ssr
an
ureetii-xj kne for ar/ikd reopknt names: ;
Task Pane.
jo«r Sr «• Madam,. 3‘
Choose the format that best suits your
needs.
Match Felds...'
3 phua and Cynthia

3 JT

Dear Joshua and Cynthia:

11 .We have one more item to include in our letter and that is the student’s
name. To do this, we place our cursor in the last paragraph between
the words with and this. Next, we click on
Insert Me
[7.3
Insert;
More items.
f Address Field?

The following list will pop up. You need to
select Student and click Insert. If you look at
your letter, you will now find this “«Student»”
in between with and this.

.71

Last
First
Address
Gty
State
Zip
Phone

Marthfields.,.
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<• titebise Fields

E«Ms:

Insert

1

12.The next step will allow us to preview our letter. Click Next: preview
letter in the Task Pane.
Use the
double
arrow keys
in the
Preview
your letters
section to
scroll
through the
letters.

You are now
ready to
take the
next step,
click Next:
complete
the merge.
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13. You are now able to Print your letters by selecting
print in the Task Pane or you an individually edit each
letter by selecting Edit also in the Task Pane.
14. Once your letters are printed, they are ready for
distribution to your students. Your project is complete!

Print...

£dfc indMdualtetters...

I

I

j
Step 6 of6........... .........
<$j Previous: Preview your tetters
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Sample Letter for Mail Merge Project

The Children’s Center
7177 Potomac Street
Riverside, CA 92504-3935
(909) 784-0020

April 28, 2003

Harry & Marcy Rosen

4285 Denver St

Riverside, CA 92504

Dear Harry & Marcy.
I am writing today to let you know that “Back to School” night will be held on
Wednesday, September 15, 2004. We will have two sessions in order to
accommodate parents with more than one student attending the school.
The first session begins at 7:00 p.m. and the second session begins at 7:45
p.m.

During our time together, I will review the learning objectives for the year,
and plan to share my educational philosophy. Since I know many of you will
want to get involved by assisting in the classroom or with the parent support
group, I will have information on both these areas as well.
In closing, I am really looking forward to working with Brook this year, and I
hope you will be able to join us to learn more about the educational journey
we just embarked upon.

Best regards,
Your Name
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PowerPoint Project
Microsoft PowerPoint is a presentation graphics application program which is
frequently used as an alternative to an overhead projector as PowerPoint
displays information directly on your screen for the audience to view.

The objective of this next assignment is to use PowerPoint to create a
slideshow presentation. For our example, the slideshow presentation covers
how to create your presentation. During this lesson, you will learn how to add
text, graphics, animation and sound. I am sure you have already begun to
think of applications for this project. Whether its creating a presentation to run
during open house or to add some pizzazz to your next lesson, I am sure you
will find many occasions to use PowerPoint!

Darcy Coulter
Masters Thesis
California State University
San Bernardino, California
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Part 1 - Creating a PowerPoint Presentation Using the Wizard
The steps are as follows:
1. Open MS PowerPoint,
This screen should
appear.
For our first
presentation, we will
be using the
AutoContent Wizard.
Like all other wizards
used in the Microsoft
products, the wizard
will save us time.

Click to add title
Click to add subtitle

®|lll

ipuc to aid i

2. From the menu bar, click File, New.
*1 £. t

*

As you can see, the
"'"I": task pane for New
Presentations popped
up on the right-hand
side of your screen.
|| Ql(JR;SwsCeUj
i»KFTe£®'olt<bti<>-|
Lx ffomAitnCan[
<«Wtf.s.»'dUpn:
Under ‘New’ you will
;1j:NewrromeKHt
lnapre*ent
ChoasotrewnUt
oi . , . ,
find the option for
A
‘AutoContent Wizard.
■ '.ajtTeref’ontfoJUsonr
stwfinfhtiYorfosrflbSSw.
t .ow .
Click on AutoContent
Wizard and click OK.
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The Office Assistant
asks you if you need
help with this feature.
Click No.
Here we see the path
the AutoContent
Wizard will take us
through to create your
presentation.
It begins
with
‘Start.’

Click
Next to
move to
the next
step
4. Select the type of presentation by choosing General. Then, select
Training in the white scroll box.

As you can see, there are many
other choices in the
AutoContent Wizard to choose
from.

Click Next as we are not
finished just yet.

The next step is asking us to determine what type of output will use. Since
we are planning on creating this
presentation for our classroom,
we will accept the default with is
‘On-screen presentation.’
Click Next
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6. At the Presentation options dialog box, enter the presentation title,
“PowerPoint Project.” Click under “Presentation title” and start typing, then
tab to the text box and put your name in the footer. For this presentation,
uncheck Date last updated and Slide number.

Click Next, and then click Finish.

7. Your screen should have two panes: the outline pane, and the slide pane.
You can see that
Sh/w frvlfw t*»
Is £> U ««•*
presently, the
sn" . n . ii h gflr; ~
/< *’ <
‘Outline Pane’ is
displayed. This
allows us to view
the proposed
PowerPoint Project
outline for our
Darcy Cojllter
presentation.
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Me.. F«d.30tKstt$.

3>o.wWre3C
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i (cj PowerPoint Project

Dacy Coulter

z'g Introduction

• Cefire toe afcject matter
• State yrfatthe audience will tesm to
session

3 $3: Agenda
»List too topes to bo covered
• Ltettoe times allotted to each
4

The Slide Pane
allows the
creator to view
each individual
slide.

Overview
• Give toe big pictorc of toe sdsject
• Explain how all the ndfrcusl topics fil
togetoer

5 ifcil Vocabulary
• Ghsssay of terms
• Eeilne toe terms as used to tois stfaje •

«i^j Topic One
• Explain details
• Giveanexarrpte
• Exercise to retort

t

Topic Two
• Explain details
• Give an example
• Exercise to retort

I

• « »

« » ,

j fiSjPioievrfrtwnS
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8. I would suggest that you save your presentation frequently as you don’t
want to loose your hard work. To save your project, select File from the
menu bar, and Save As.

'Save in:
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fri

ffliEaBBgig
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Cj
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Ji
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My Documents

i
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1

l±J

Ji

Favorites

' .

23
Surnme! Institute
Pl My eBooks
Q My Music
23 Cbaffey CoBege Course info
23 Cftaffey Efnpic&'msnt Documentation Gj My Pictures

23 Community Settlement Association

;

23 Consulting Clients
23 Couites Financial Information

My Webs
22) Palm Programs
Gj Pil^im Church

23 Creg Stuff
23 CSUSB Documents

23 PowerPoint Presentations
23 Teaching Employment Information

23 Dalen's School Work
23 dogs Videos

C2i Training Programs
Q ULV information
If) dogs

Dffefh
23 Kara’s Documents
23 Lesson Platts

SttJPilgrim Congregational Church

Presentation!

My Data Sources

ts

nie came;

I PowerPoint Project

”3

Save as £ype: fe^ent^lon

When the dialog box
appears, the File
Name should be
“PowerPoint Project.”
You may choose to
keep this title, or
name it something
unique.
You will also note that
under Save as type,
Presentation is the
default.
Click Save.

Whenever you want to save to a different location, from the File
menu, choose Save As. You are also able to save the same
information under a new file name using this method.

9. With your presentation in Outline view, you will want to modify the text that
was automatically placed in the presentation when it was created. On the
first slide, make sure your name is below the title ‘PowerPoint Project.’
Now, type the name
'• •■■■ e;
pi'.-." s ’■■
of your school, for
. wwj’w ww x, ,tiis
example “The
1
1
Children’s Center,”
and press enter. Type
PowerPoint Project
the city and state.
Darcy Coulter
it»
The Children's Center
Your outline should
Riverside. California
have the following
• Quo
of
information on the first
slide.
•• OnfObasarins tyoeoftetermrm*s used to St*
ropt• s»elc 0iB«nd£tofcs
.fiwr ®anb
Please note that you
■i 1 >> i
can either type
EIsB
directly on the slide or
‘a •>? i.ES A. -'-..-w■
jgu.
in the outline itself.
Try both ways!
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»«•» fyraf

« y' *4 .MV‘>

i (fT PowerPoint Project
Oa-sy Center
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J (Si Intradidstion
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»List tf*> times slatted tn each
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together
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10.To replace text, click in front of the word to be replaced; then click-anddrag the mouse to the end of the text. For
example, on the next slide, we will replace the
l ;S3]i PowerPoint Project
Darcy Coulter
word “Introduction” with the words “Presentation
The Children's Center
Riverside, California
Plan” by following this procedure.
? Outline \ Slides

___ _______

• Define the subject matter

With the word “Introduction” highlighted, we will
replace this word with “Presentation Plan.”

• State what the audience will leam In this
session
• Find out any relevant background and
interest of the audience

11. Continue replacing the remainder of the information on with slide so that
your slide looks like the one below.
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The remaining bullets
describe the essential
components of preparing
a well throughout
presentation.

© Create, .a Storyboard
©Write Text
« Add, Graphics or Photographs
© Put in Links
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12. We want to delete the next slide. To do this, you need to click on the

miniature
picture of the slide right next to the number. For our
presentation, select the slide titled “Agenda.”
Notice that when you do this, the entire slide is highlighted. Press the
delete key. This removes the slide.

If you make a mistake and decide that you no longer want to delete the
slide, do the following: a) from the edit menu, choose Undo Clear (Ctrl+Z),
orb) use the'L/ L Undo button to undo the last action.
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13.To add a slide, you can press the New Slide /a~w5UeJ button found on your
toolbar or using the menu bar, go to Insert, New Slide.
You now see
that when you
request a new
slide,
PowerPoint
automatically
selects a slide
layout for you.
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But it also
brings up the
different types
of slide layouts
for you on the
right hand slide
of the screen so
you can choose
the appropriate
layout for your
slide.

Here are some Presentation Guidelines.

To delete a title or graphic on a slide, move the mouse cursor on
top of the graphic until it becomes a four-headed arrow and click on
it. Next, press the delete key.

Part 2 - Inserting WordArt
1. To insert WordArt in your presentation, click on Insert WordArt button
found on the Drawing toolbar at the bottom of your screen, or use the
menu path Insert, Picture, WordArt.
B§sV-l............
J
.
[VI AutoSbapes- \ \ □ O SgfjZ 'S £3
Slide 4 c 9
paring
...♦ I, V. Xl~ -. O.
1 ■ insert
—»-r»—WordArt
-■'
.
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Let’s go back to slide 1 and change the title of our presentation to
WordArt. First, we will
need to delete the title
that is there by
clicking on the title,
and then clicking on
the outer box until we
see the four-headed
arrows. Next, click
delete.
The original title
should have
disappeared.

At the dialog box, select the text that is in the third column, second row,
and click OK.
fotdArt Gallery

_

**

BE3|

.

Select a WcrdArt style:

Itiferd&t tyonlAW 7>■A W
:
1
7
W,
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i WordAit
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1 All
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Wfi/uf
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i
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OK
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At the Edit WordArt Text dialog box,
the text is highlighted. Type “Creating
a PowerPoint Presentation.”

Be sure to put returns after ‘a’ and
‘PowerPoint.’ You will also need to
adjust the remaining text on the slide
so that everything can be seen.

(
t

Cancel j *

Here is an example of the finished
slide.

Under the Word “Size, Click on 36 and choose 44, then click OK. The
WordArt is now in the middle of
Erfft WordAii Text
:»wb
the slide along with the WordArt
-IT’KI
'
Anal Black
44
Toolbar. Move your mouse
I«xt:
24
cursor on top of the WordArt
title until it turns into a four
headed arrow. Next, click-anddrag the title above your name.
Release your mouse.

'•J;

ei
:■
ft

Creating a
PowerPo int

Your title slide should look
something like this.
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If you want to change the shape of your
WordArt title,
click on the
WordArt Shape
button on the toolbar.

For my title, I selected “Can Up.” Sometimes you just
need to try out some of the styles to see which one
you like best.

To edit your WordArt text, double-click on any part of the WordArt
text, and the Edit WordArt Text dialog box will appear.

Part 3 - Insert Clip Art
1. To insert Clip Art, click the Insert Clip Art button on the
Draw toolbar. You can also access Clip Art by using the
menu options Insert, Picture, Clip Art.
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Insert Clip Art)

You will notice that
when you clicked on the
Insert Clip Art button, a
new task pane
appeared on the right
hand side of your
screen. Fill in the
“Search For” blank with
the name of the clip art
object you want to
search for. In this case,
type in “Presentations.”

As you can see, different clip art pictures will appear. Use the scroll button
on the right hand side of the pictures to scroll through the remaining
■
pictures.
x’i

For this presentation, we will select the picture
highlighted.
J -i>

'insert Op Art .

y ,’X;

Once you are ready to insert the
picture, click on the down-arrow
J J,; button. The following drop down
j J menu appears.

| Results:

iryk J

To insert the picture, select Insert.
This inserts the picture on the slide.

. wxa
£

err

cSs

" corwiiriicQttons. mh!es, men.,,
175 Cw) x 115 (h) pixels, 13 KB, GIF

j Insert

JfeLCopy

deletefromiCto Organirer
; :2penC5ptn««. .
BIX Tools on th? Web, ,.

itatio,

Copgto Collection...

r,"nj.£<tekeywor<J»X«
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Darcy Couiti

XFind5lffl8af§tyte;

The Childrer
Riverside, C

... • >. Previeia/Properties:

You many need to relocate and resize your picture. To relocate/move the
picture, follow the same pictures as you did with the WordArt, Click-anddrag on the picture.

To resize your clip art, select you image so that the size handles surround
it. Position the mouse pointer over a corner handle until the pointer
changes to a double-headed
diagonal arrow.

Creating a
PowerPoint

Click on the corner size handle
and drag the mouse toward the
picture to make the image
smaller or away from the picture
to make it larger. The middle
size handles distort thfe object.

Darcy Coull
The. Childrei
Riverside, G
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Here is the finished title slide!
If you make a mistake, go to the Edit menu and choose Undo
Resize Object (Ctrl+Z).

Part 4 - Changing the Appearance of Text
1. To change the appearance of text, click in the middle of text, and then click
anywhere on the crosshair border to select
the entire text box.
Now you can use either the Format toolbar or
the Format menu to complete your formatting
changes.
If you use the Format
following dialog box will
Here, you can make
to fond, font style, size,
among others. Try using
Shadow button to create
effect to tyou text.

k Darcy Con It
j The Children’s^Cent&iv
iRhsci side, California -"

menu, the
appear.
changes
color
the
a unique

Part 5 - Printing the Presentation
1. To print your presentation, click File, choose Print. At the Print dialog box,
select current slide, one copy. From the pull-down menu opposite Print
What: select Slides and click OK.
l?»xl
You are also able to print an outline
I
|EF^ON Styk«C^I Series
T,
73
of your presentation, handouts, 2, 3,
Status;
M
EPSON SlyU CWS«i«
Type*
4 or 6 to a page and your
i Where:
IFT1:
I Comment;
f” Print to f^e
presentation with notes pages.
• Pnntrange
r Copies ••• —
! Number of copies:
Aii ,
C Current sWe Cr;
Also, at the Color/grayscaie box,
73 . fT“3
I
i
f ”
'
i
•nJ -nJ you can select to have your slides
' Enter sFde numbers ard/pr slide ranges, For example,
1,3,5-12
print out in color, purely black and
P Col.j'ts
Print vvhat:
white, or grayscale. I recommend
30
R3
Grayscale.
QC3
Cofor/gre’/sca'e:
SB
[c5w
73
b

r
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r Frame skies "

F~?IfKlude comment pages
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Part 6 - Adding Animation and Sound
1. We will now animate the title of the presentation so that it swivels to an
applause sound. To do this, we must be in Slide View or Normal View.

Go to slide 1 and select the title “Creating a PowerPoint Presentation” so
that it has size handles.
*
From the Slide
If, I Show menu, select
Custom Animation.

iip
iTI g 11
j ww.Sit».weia} i <■ * A

When you
I completed this step,
i

j
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The new animation features of XP allow you to automate a something on
1) entrance, 2) emphasis something while on the
- X
screen and 3) as the item exits.
You can also create custom
Jf*
motion paths for each item.

2. At the Custom Animation
dialog box located on the right
hand side of the screen, make
the following selection from the
Add Effects tab:

Click anywhere in the area
of the WordArt title
Click the down-arrow on the Add Effect
Click Entrance, and More Effects
The Add Entrance Effect dialog box appears which have basic, subtle,
moderate and exciting effect categories to choose from.
Swivel, the effect we have selected is in the exciting category.
Click on Swivel and OK.
3. To add a sound to an animation, the text or object must already have an
animation applied to it before you can complete this
process. On the slide, select the text or object you
Modify: Swivel
want to add an additional effect to, in this case, the
d Start: P& On CM
title.
Direction:
Custom Ansnabon

Add Effect •*} ]*$

Speed:
L fcerySfoa

Horizontal

On the Slide Show menu, click Custom Animation.
In the Custom Animation task pane, click the arrow
on the selected item in the Custom Animation list, and
then click Effect Options.

1 "ft

Remove I

Text itOarcyCouk...

£§] Start On gkk

Start With Previous
j Start fitter Previous

On the Effect tab, under Enhancements, click the
arrow in the Sound list, and do one of the following:
■ If you want to add a sound from the list, click an
option.
■ If you want to add a sound from a file, click Other
sound, and then navigate to the file.

• Effect Options,,. ;
TWrrg.,.

Show Advanced. Timeline

fiemoye

0 Re-Onfcr
j >■ May I @r
!Jl| Itt AutoPreview
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For our project, go to the down arrow on
sound and select Applause, and click OK.

You are also able to control the timing of the
animation effects as seen on this dialog box.
Swivel
Effect

Twins |

Sfsrt:

Jd5 OnCkk

E-stays

If

Spged: '

15 seconds Ciwy Sow)

aepeet'

|(nonej

....

v|t

3

OK

|

Caws!

fji

.

j-J

1

, TRessM when (tone playing'

Follow these same procedures for animating text, Clip Art (graphics) and
WordArt throughout your presentation. My only caution is to seriously
consider how much animation you add. Just because you can add
animation, too much animation can detract from the presentation.

Part 7 - Creating an Action Button
1. In most instances, you will want to advance your slide manually. You can
advance a slide by using the keyboard’s Page Down key and Page Up key,
or by clicking on your slide.
Adding an Action button lets
you jump to any slide, go
backward or forward, or stop a
presentation.
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From the Slide Show menu,
scroll to Action Buttons, and
then select Action Button:
Forward or Next.

..

fftj- Aremahnn Sthenws..
CustotaAramatton..
GJ ; SW?
Add3CTfao«joo... .
C& SdtoSkfc
C05taB»5boE£j.„

68

►

2. The mouse pointer is now a cross hair. In the lower right-hand corner, clickand-drag to draw a small button. Release
SSSBJB
the mouse.
f Mouse Cfck j Mouse Over j

Action on cSfCk

The Action Setting dialog box appears
allowing you to Hyperlink anywhere in your
presentation, to any file on the computer,
or to the Internet. This can be a handy tool
in class!

0:

<

O

For this project, Hyperlink to: Next Slide,
from the drop-down menu

"Cancel

Place check in box to left of Play sound:

Play sound: Arrow from drop-down menu and click OK. If the action
button needs to be relocated, simply click on the action button until you
see the four-headed arrow. Once the four-headed arrow appears, you
can grab the button with the left mouse button and move the button, just
like we did with the clip art and word art.

Part 8 - Changing the Color Scheme and Slide Transitions
1. From the Format menu, choose Background. In the
dialog box, select the down arrow. Here, you can
see more colors and various fill effects.
Let’s select the yellow color (the 6th across) and
click Apply. This changes the color to that one slide.
If we selected Apply to All, it would change the slide
color of all the slides in the presentation.
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rBackground fil

, ApplyfcoAfl

2. Transitions are special effects that transport the user from one slide to the
next. Let’s add a transition to slide two.
From the View menu, choose Slide
Sorter, or click on the Slide Sorter
button on the bottom scroll bar.
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3. The Slide Sorter dialog box appears.
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Click on the slide you want to add a transition to, in this case, slide one.
From the Slide Show menu, choose Slide Transition. You can also
select the Transitions icon from the format toolbar.

Select the
following from the
Slide Transition
task pane.

Effect:
Checkerboard
Across
Speed: Slow
Advance: On
mouse click
..
i: P(“enAifcmow#
xnsilcidiSsysfk ter
I r—r__
| WK, «l3»s 1
1. ... I |3J!

Sound: Push

You can Apply to
All Slides or the
slide you have
highlighted, in this
case, slide 2.
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Part 9 - Ending Features
1. To prevent the PowerPoint program from appearing at the end of a show,
you can end the presentation with a black slide.
From the Tools menu, select Options. Click the View tab. Under Slide
Show, check End with black slide and click OK.

2. If you want the PowerPoint program
to continue looping, you can set
that option by completing the
following:

' Show type

, -Show sSdes •

' <♦' Resented by a speaker (M screen)'

| f, grossed by anfndmdua! (window) '

r C&aw

hr,

,

\ O-Brwsed et a fcosk tful screen) •

From the Slide Show menu,
choose Set Up Show.

h3

-----------rAdyanceslides|, Pto^contrwu^u^’Esc'
F r Manually

I riShoww^outoarrabon
<: f*, Show without animation

Under Show Options, check the
box Loop continuously until ‘Esc’

I ’ & Using tiroes, if resent
I i Mdl-pie faorvt&rs ■ -

I Pgncetofijz
Ir-! Psrfcrnrtance :

4 H Use hardware Qrephxs acceleration ■
j SWe show tesoUloo: jtUse Cutrent ResZtlMl] "
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3. To view the slideshow, select from the Slide Show menu, View Show.
Click on each slide to advance to the next one. Click on the black slide to
exit.
4. To save and quite the slideshow, select from the File menu, choose Save.
To leave PowerPoint, from the File menu, select Exit.
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Certificate Project
Teachers enjoy rewarding their students. Many times, this gives a
Certificate of Ward to show the student how proud there are of their
accomplishment. In this next assignment, you will learn to:
Enter text on a MS Word document
Insert WordArt and Clip Art
Insert a Page Border

The steps are as follows:

Part 1 - Inserting WordArt
.
1. Open MS Word to a new
document.

‘

Bdit View
£ (j ' fire*..
•w I Irjert

D

rS

Took

Pate and Time.,,

im
111

3. At the WordArt Gallery select
the WordArt that is 3 across
and then click OK.
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"J * Cancel
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Symbol...

ftefereote
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Picture
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® gpftrt...
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From Scanner or Camera,..
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Select a WordArt style; :
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2. From the Insert menu, Picture
and WordArt.
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Drawing
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, &>r*i______________ gtze:
Monotype Corsiva
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4. Choose the find Monotype
Corsiva from the Edit WordArt
dialog box. Type “Student of the
Week,” and select the font size
of 48, and click OK.
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____ '

____ _

Student of the
Wfeefc
E
5

j

C>

Cancel

5. Center the WordArt on the page by going to Format menu, select
Paragraph and under “General” take the option to Align Center.
6. Add a few additional lines by hitting the Enter key a few times.

Part 2 - Inserting Clip Art
1. From the Insert menu, drag to Picture, and then choose Clip Art.
From the Microsoft Clip Art
Gallery, click the Pictures Tab.

Tgfete

i
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'
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Hdp
- sin n

The Insert Clip Art dialog box
appears. In the Search text box,
type in awards
and click on
Search For
Search text:
Search.
[awards
4. Scroll through
the list, using
the scroll bar
on the right
hand side of
your screen
until you find a
clip art you
want to insert.
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Searching
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Lgf &utoShap8$

Ctrl+K

41
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When you find the picture, click on the down-arrow, and then click Insert.
_Insert'CiipArt
This inserts your picture on your certificate.
~Jf~
:

Resutsi

To move the graphic, click on the award graphic
and from the Format menu, choose Picture.
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7. When the Format Picture dialog
box appears, select the Layout tab. If
In-line has been selected, select Tight
and click OK.

This allows text to appear all around
the graphic and tends to provide the
most versatility.
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Xn fine wkh text
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Horizontal alignment -■
C ysft
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In front of te> t

^Qther

h.
8. To resize your picture, click on the award to place your size handles (small
squares) in each corner.

Click and drag up toward the award to decrease the size (drag away from
it to increase the size).
Move the cursor on top of the picture until it turns into a four-headed arrow,
and then click-and drag to position the picture.
Place the picture inside the margins, otherwise, it will not print.
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9. Using the underline key, create a line for
the students name in the middle of the
page, directly under the graphic.
Continue typing the remaining elements
of the award. A sample is provided.

Liuftnt °ftie

Part 3 - Inserting a Page Border
1. The last step to our certificate will be to
create a page border.

*5 r«fa-SUPERanZttn'r
lUr,.teen-siBK,.<fcfe«z,CTdftrtei
T
The-week-oHI

From the Format menu, choose
Borders and Shading.

The Borders and Shading
dialog box appears. Select
Box and scroll through the
Art at the bottom of the
dialog box, until you find a
page border suitable for your
certificate. There are many to
choose from!

Awarded"by:-_

Bouteis and Shading
Page Border | ghedrxj

Once you find one, click on the border and
click OK. Your page border now appears on
your certificate.
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2. To save your certificate, from the File menu, choose Save As. When the
Save As dialog box appears, type a name for your document, such as,
“certificate.” Now find a location in which to save your file. Click Save.
3. To print your certificate, from the File menu, choose Print. At the Print
dialog box, choose OK.
4. If you wish to exit Microsoft Word, from the File menu, choose Exit.
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Grade Book Project
With Excel, you are able to calculate student averages for a series of tests
and record their final grades. Excel also allows you to save time so that
you can provide your students with feedback on how they performed on
the test. In the next assignment, you will learn to:
Create and format an Excel Workbook

Sort information on an Excel Worksheet
Use the formula function

With this project, you will complete the spreadsheet below.
Science 100
I Name '

-rest 1 Test 2 Test 3 Student Average
Armstrong, Marcy 1 77 ( 85
87 I
83
Cooney, lied
94
87
.84 1
.. 88
Delaney, Joe
90
92
92 I
91
; 78
72
Emerson. Jane
66
75 •
Frazer, Phyllis
94
93
94
95 ;
Goldshine, Gus
82
83
82
82 1
Holmes, Joyce
76
57
73 !
69
L 80
Rosen, Harry
95 88
87 i
Sikora, Brook
87 " 97
90

Class Average

i 85 I 82

86

______ 84

fill
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B
B
A
C
A
B
D
B
A

The steps are as follows
Part 1 - Creating
a Workbook
1. Double-click on
Excel to Open
Excel. It will
automatically
open to Bookl.
2. From the File
menu, choose
Save.
3. At the Save
dialog box, name
your workbook
“science scores,”
and click Save.

4. To begin entering
information, click in
cell A1 and type the
title for your
worksheet, “Science
100,” then press
Enter.

1 ^Science 100 _
2 iName
pesTl
3 j Sikora. Brook

{Test 3

i Student A's Fine! Grade

5 1 Armstrong. Marcv
6 {Rosen. Harry
7 iGoidshme. Gus
<MFrsx$r. PhyUis

9 {Holmes^ Joyce w
10 -Dalanev- Joe
{•jEmefson. Jane

XT

i

13j Class Average
"14!
IS?

5. When you press
enter, it places the
cursor in cell A2.
Type “Name,” and
then press the tab
key.

•Test 2

4 ~i Cooney. Ned

. ............. •

IS!
20!

w;
22]

ad...
20

2s;
27 r
28l
29 J '

30!
31!

.J "liE
6. When you press the tab key, it places the cursor in cell B2. Type “Test 1,”
press tab, type “Test 2,” press tab, type “Test 3.”

7. Follow the same procedure and type “Student Average,” and “Final
Grade.”
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8. Click in cell A3 and begin filling in the student names. Once you type in the
student name, press Enter to advance to the next cell and type the next
name.
9. Click in cell A13 and type “Class Average.”

Part 2 - Sorting Data in a Workbook
1. To sort the names in alphabetical order, click and drag to select the names
you want to alphabetize. Click the Sort Ascending button on the
Standard toolbar.

-D

S3 i <§? Gk

a

f Arial

..........

- 13 n

- C-' -

©> ’

|X

10 prB Z

%

j

-. -■Soft Ascsn&ngi

H11

;

ioq%

tw M W®,

< o ,•
-A j
V

You can also alphabetize by going to the Data menu, and choosing
Sort.

■, ^Microphone/
2. To resize the columns to fit the
data, place the cursor in the very
corner of the spreadsheet, beside
the “A” and on top of the “1.” When
the cursor changes to the “+” (plus)
symbol, click the left mouse key
which will turn the entire
spreadsheet blue.

|j

’ Fiie gat 55ew Insert farawt loos. Sate
ci

■

•

1 iScience 100
2 -iHQffls
|Test 1
s4sikora?rBSok
Icooney fed
lAmistcongl Marcy
IPosen^Haiy
|GoldshinejGus__
Frazer Ptlllis
__ 'Hoirties, diyce

View

rorTist

Insert

swa

sia?

Science 100 L
Teat
Armstrong
Cooney,H
Delaney J
Emetscsn:.. ..
Frazer; Ph >
Gatoshina,
Holmes Jr
Rosen. Ha
Sikora Bn

"Test 2
77
...04
-90
78
'94
82

1

■<16. '

. 87

Class Average

?>=

i Test 3

lOlQelaney.xpe
11 lEmerson, lane

121
f
13 iCiass Average
~W I
i
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Tools

£fit»

1 Fx -

x

E

/ S |C g 3 |
fi. Science 100

giTca

f* Sikora. Brook

■Test 2

£«&

'a<

a s -E

x

A3~

.d

Hdp

- 20 - B / 0 .BB 5 § ffiJJS % ,

_

• ES*

_____ ______ ...j.

Test 3
8537- ■
92
SS
93,
83:
57
77
.97

Student
A\ Pinal Grade
SK
87;
34
92’
75 .
95
82
73
95'
87

SB

Next, go to Format, Columns, and
select the AutoFit Selection. This
will automatically resize the columns
to fit the largest data element.

bs"p
<-*' & 2 -s:
► r aoth...
►
&utofttSe?e:t©h’

- goLroj
1 -

I

■
s

!

tiffs

3. Click in cell B3, and type “77,” and then tab. Next, type “85” and tab, type
“87,” and then press Enter. Use the four arrow keys to navigate around the
spreadsheet. Continue keying in the test scores for the remaining
students.
| saence scores

QL

i

■Hi J

___
Test 1 Test 2 Test 3 jStudent Average Final Grade
___ 77s
85s
87l
i
t
94
371
84,
5 j Delaney, Joe _
92
90
92
78"
_6 j Emerson, Jane
CO
75
931 J5i
7 jFrazer. Phyllis _
J4
32'
83l~
82'
8 i Goldshine, Gus
71"
57
76
OS
10 Rosen. Harry
95S
0
"8?
111 Sikora, Brook
97
87
12j
_______
13 i Class Average
14
JjScienc8_W0
2_iName_ _
3
4- [Cooney. Ned

4. Click the Save

c

' button on the Standard toolbar to save this worksheet.

Part 3 - Calculating Formula’s
1. To calculate the student average, click in cell E3. This is where the
average score for Marcy Armstrong will appear. Type “=” in the cell as this
lets Excel know that you are typing a formula.
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2. From the Formula Bar, use the Functions drop-down menu to choose
Average. You can also use the menu path Insert-Function.

csi

a

sty

s

gj

i

x

y■x

£ s

- Z its 4
ll

ft =

iTest 1 iTest 2 :Tsst 3 iStudent Average :Final Gradei,
tatty
85 f ~87|1/ _ _L
S4i
871
84.
90!
92!
921
68!
76,
751
S3!
!
94!
95!
83
‘
82
821
571
9 iHolroes. Joyce
76i
A
'77r 3sf
10 iRosen, Hany
86!
11 iStkora, Brook
97!
07
87!
121
13 i Class Average
"14!

t/~W

At the Average dialog box, cells B3
through D3 are chosen. If Excel
had chosen the wrong numbers,
you would simple need to type the
correct cell references in the cell.
Click OK once you verified that the
numbers are correct.

ttxnctxm Argumen

Retm ns we
(anth<reoc man) of Its arg.irients,
arrays. orreftrercesthatcwteinnurrbefs.

Humbert: cumber LnurberZ.
the/averages-

can be numbe-s tr names,

i formula result.«

fe'pon tinstimton

You should see 83 in cell E3.
You will be using the same formula to calculate the average for the
remaining students. To use the shortcut method, select cell E3 and drag
the fill handle down, or double-click on the fill handle.

4. To calculate the class average, click in cell B13 and type an “=” sign.
From the Functions drop-down menu on the Formula Bar, choose
Average again. When the Function Arguments drop-down menu
appears, verify that the cells referenced are correct.
Select cell B13 and drag the fill handle across to calculate the remaining
averages.
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i

are i to 30 owic argoffsents bi when y-saj want t
.
-s. ,. I

5. Since some of your numbers are have too many decimals, select the
numbers in the table you
? QB Tool®
want to change. Locate the
Rie £dt jev, (osert format *005
a^doi* £eb
'■ D & O s9 tiI & B. ‘
J X a
S’- ’ <& £ ’ 44 S4 SS <? 4.
Decrease Decimal Place
',-wT
-.o
/ u '»
a ffi, SB % , Mg]
button on the Formatting
M
E4
i» • ... A; °AVERAGEjB4:p4)
Decease
toolbar to round to the
A
,
nearest whole number.
[Science 100
1

[Name
Teel Test 2 Test 3 /Student Average /Final Grade |
7?
[Armstrong. Marcy
SO:
8?
331
94
J Cooney. Ned
84
87'
88.33333333
j Delaney. Joe
92:
91 33333333
90
92
J Emerson. Jane
33333333
76
66:
7o
941
[Frazer. Phyllis
94
93;
Sol
82l
[Goldshine. Gus
83;
821
82.333333331
7CX j57
73:
66.66665667)
[Holmes.. Joyce
J6f
JRosen. Hany
77.861
95
1 Sikora. Brook
90.33333333T
G?
97;
87

6. Perhaps one of the hardest
aspects of the grade book is
determining the correct
formula to figure the letter
grade. Click in cell F3 and
type the “=”sign.
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jCjass Average

i 34.6?i 31.89. 85.56i

84,O3?G3?04T

Next, type the following formula as is:
IF(AVERAGE(B3:D3)>89,”A”,IF(AVERAGE(B3:D3)>79,”B”,
IF(AVERAGE(B3:D3)>69,”C”,IF(AVERAGE(B3:D3)>59,”D”,”F”))))

u .Mu u |
=^5 tag > o>;xp. v- _ ’ v” a’. " “ “ " ’ ““
;<&r^lF^V^GE^?D3K8C^iF^^WBW>79?B\IFiAVe^<g^3:O3ftg9.X\IF(AV£RAGEiB3:D3>$9‘DirT, lffl '
jc

F3

Science 100
Name...

J'

Cooney, Had

[

”*77*

Delaney. Joe
|
Emerson, Jane
(
Frazee Phyllis.. _ J
Gcidshine, Gus <
jHP.i’nss, Joyce
T
Rosen, Harry........ {
■Sikora, Brook
j

[Class Average

85~

94*
SO:
76*
94!
82*
761
88*

87.
92:
66
93;
83,
57,
77;
..Si ...... 97;...

85[

82;

p.„
84*
92j
75*
251
82!
73!
95;
871

ssi

file
33*
Si!
72!
94*"

..........:.....

32!
691
86:
SOI
”84!..

Press the Enter key; a value of B if recorded in cell F3.

Move the mouse to the lower right corner of cell F3. When the cursor turns
into a small black plus sign, pull down the fill handle through cell F11.
Excel has now calculated the letter grade for each student.
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Part 4 - Formatting a Spreadsheet
1. To format the title, select cells A1 through F1, and then click on the Merge
Iff
«
on the Formatting toolbar.

and Center button

2. You can quickly format this table by using Excel’s Build-in formats.

Click-and-drag to select the
cells in your table.

^*Ucrcphoro E^TooJs

E3 Microsoftfoccel

Insert

Vet*

F^mt

gata

Too-s

^idow:

Ijgi«i © Bi V1 X £h©-<7
a

f

J"

- <-■« <
|

Science 100

z - M £1

It® % s \
Merge atfCeaMer|g

jAnnstrong, Marcy}

jPejaney, Joe

|

jEnwrson, Jane
iFragsr Phyllis
l(3pldshiriQy Gus
lKgim8s“jo^9

i

ISikora, Brook

jiCiassAverage

3. From the Format menu, choose AutoFormat.

In the AutoFormat dialog box,
choose the format you want, for
example Classic 2, and click OK.

s 51®
IP,r-a

You can then make additional
changes to this formatting such
as font size, centering, and
shading. For this example, we
-- —Vjjy.
Jtf?? rs& Mar Total i»‘
Jan Feb Mar Total LEast
7
7
$
7
7
5
1Ssf
S
4
7
17 ji West
5
4
7
17 p
6
7
$
24 h SciiiO
5
7
9
24f
21
18 21
Sfi H
Total
21
18
21
50 is Total

East
West
$c«h

Gass,ci ,

. Swp'e

(

East •

7

7

5

$test!

8, 4

7

booth

3

&otat 21

te-d ~l.
Spans'.., |’

East
West
Soutn

7

IS 21

38

Total

?
75
€
i
1S - 7
s~

21

1$

21

’jtew Insert j Ffrmat j Tods

I c-3 i»j

<!fl C{?«- ■
V 10 |

lj science scores
A

'"&nfoy<

' Si Si'l

►

kSfcest

S
|L

|i /fcrephon.
tSP- '

' 1
F
'i Coo^tionatFemiatSng.,/ •
*.......
Average Final Grade
- Armstrong, Marcy ’
no
97 .
84' ,
4 Cooney; Ned®
63 B
* ' z\
Delaney. Joe,
,90 - 92 '.92-.,
.
.76'
' 65
75
’
Emerson. Jane «
” C
94 , 93 ' 95 "■
Frazer, PhyJhs
'.4
8 GoldsMiie.,Gus
82
33 '
32
61 i?
IP Holmes, Joyce
,78/ 57. >73
Pf, ",
13 Rosed, Harry
88
77
“95
•CC
'•
1.-.
r
37
.97
,87
11
. A
1
£

i
’

UsmT^

13 Class Average
itt i

,
I

32 ' 86
i
i

u
!

added centering, increased the font
size, and adjusted the widths of
columns.

EC

4.To print your spreadsheet, choose
Print from the File menu. At the
Print dialog box, choose OK.

jt

7«£2< ;!
ter,
m «
jan Fee &»ar Tatar
East 5 7 5 7 S 5 5 15
East 5 75 75 5 S IS'
1? H West
Wes!
5
4
a
8
7
17
24 j| Scuta
Scam
3
5
7
7
5
9
24
Tcfaf S 21 S 18 S 21 5 «0 i| ratal s 21 5 18 S 21 S 8C
- . ..... i|
—..
....... -......
Accounts 1
A:«saiftig 2
"Tlii-
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